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PREFACE

Thank you for purchasing this product. The materials available in this Manual (the “Manual”) have been
prepared by JAVAD GNSS, Inc. (“JAVAD GNSS”) for owners of JAVAD GNSS products. It is designed
to assist owners with the use of the TRIUMPH-1 and its use is subject to these terms and conditions (the
“Terms and Conditions”).

Note: Please read these Terms and Conditions carefully.

Terms and Conditions
USE – JAVAD GNSS receivers are designed to be used by a professional. The user is expected to have a
good knowledge and understanding of the user and safety instructions before operating, inspecting or
adjusting. Always wear the required protectors (safety shoes, helmet, etc.) when operating the receiver. 

COPYRIGHT – All information contained in this Manual is the intellectual property of, and copyrighted
material of JAVAD GNSS. All rights are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any third party access to, any graphics,
content, information or data in this Manual without JAVAD GNSS’ express written consent and may only
use such information for the care and operation of your TRIUMPH-1. The information and data in this
Manual are a valuable asset of JAVAD GNSS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by JAVAD GNSS.

TRADEMARKS – ModemVU™, JAVAD GNSS® are trademarks or registered trademarks of JAVAD
GNSS. Windows® is a registered trademark of Microsoft Corporation; Bluetooth® word mark is owned
by the Bluetooth SIG, Inc. Product and company names mentioned herein may be trademarks of their
respective owners.

DISCLAIMER OF WARRANTY – EXCEPT FOR ANY WARRANTIES IN THIS MANUAL OR A
WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE TRIUMPH-1
ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. JAVAD GNSS DISCLAIMS
ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. JAVAD GNSS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING,
PERFORMANCE OR USE OF THIS MATERIAL OR THE TRIUMPH-1. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION
OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT'S USE. IN
ADDITION, JAVAD GNSS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE,
CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, JAVAD
5www.javad.com                                                                                                                                             



Preface
Terms and Conditions
GNSS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE TRIUMPH-1. 

LICENSE AGREEMENT – Use of any computer programs or software supplied by JAVAD GNSS or
downloaded from a JAVAD GNSS website (the “Software”) in connection with the TRIUMPH-1
constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such
Software under the terms stated herein and in any case only with a single TRIUMPH-1 or single
computer. You may not assign or transfer the Software or this license without the express written consent
of JAVAD GNSS. This license is effective until terminated. You may terminate the license at any time by
destroying the Software and Manual. JAVAD GNSS may terminate the license if you fail to comply with
any of the Terms or Conditions. You agree to destroy the Software and manual upon termination of your
use of the TRIUMPH-1. All ownership, copyright and other intellectual property rights in and to the
Software belong to JAVAD GNSS. If these license terms are not acceptable, return any unused software
and manual.

CONFIDENTIALITY – This Manual, its contents and the Software (collectively, the “Confidential
Information”) are the confidential and proprietary information of JAVAD GNSS. You agree to treat
JAVAD GNSS' Confidential Information with a degree of care no less stringent that the degree of care you
would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict
you from disclosing Confidential Information to your employees as may be necessary or appropriate to
operate or care for the TRIUMPH-1. Such employees must also keep the Confidentiality Information
confidential. In the event you become legally compelled to disclose any of the Confidential Information,
you shall give JAVAD GNSS immediate notice so that it may seek a protective order or other appropriate
remedy.

WEBSITE; OTHER STATEMENTS – No statement contained at the JAVAD GNSS website (or any other
website) or in any other advertisements or JAVAD GNSS literature or made by an employee or
independent contractor of JAVAD GNSS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability). 

SAFETY – Improper use of the software can lead to injury to persons or property and/or malfunction of
the product. 

MISCELLANEOUS – The above Terms and Conditions may be amended, modified, superseded, or
canceled, at any time by JAVAD GNSS. The above Terms and Conditions will be governed by, and
construed in accordance with, the laws of the State of California, without reference to conflict of laws.
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Preface
Manual Conventions
Manual Conventions
This manual uses the following conventions:

Note: Supplementary information that can have an affect on system operation, system performance,
measurements, or personal safety.

CAUTION: Notification that an action has the potential to adversely affect system operation, system performance,
data integrity, or personal health.

Warning: Notification that an action will result in system damage, loss of data, loss of warranty, or personal injury.

DANGER: UNDER NO CIRCUMSTANCES SHOULD THIS ACTION BE PERFORMED.

Screen Captures
This manual includes sample screen captures. Your actual screen can look slightly different from the
sample screen due to the receiver you have connected, operating system used and settings you have
specified. This is normal and not a cause for concern.

Example Description

FileExit Click the File menu and click Exit

General This format represents titles of dialog windows/boxes, 
names of menu options, identifies program interface 
objects, such as checkboxes, edit boxes, radio buttons, 
etc.

Temp This format is used to enter various string information 
(e.g., file and directory names) as well as operator 
commands.
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Preface
Technical Assistance
Technical Assistance
If you have a problem and cannot find the information you need in the product documentation, contact
your local dealer. Alternatively, request technical support using the QUESTIONS system at the JAVAD
GNSS World Wide Web site: www.javad.com
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Chapter 1
GETTING STARTED

ModemVU is a comprehensive Windows software product designed for configuring embedded radio
modems of the receivers developed by the JAVAD GNSS. 

Before you start using ModemVU, you should become familiar with its functions and learn how to install,
launch, exit and uninstall the program. 

ModemVU provides the following functions:

• Connecting a PC to an internal (integrated) and external JAVAD GNSS radio modem via a serial
port or Bluetooth® wireless technology.

• Displaying information about the JAVAD GNSS radio modems external and installed in the
receiver.

• Programming different JAVAD GNSS radio modem’s settings.

1. Setting up ModemVU

1.1. System requirements 

Check that you have the following required (or recommended) items before installing and using
ModemVU.

• PC-compatible with Intel® Pentium® 100 MHz or faster.

• 10 MB free disk space. 

• 32 MB RAM or more (64 MB recommended). 

• 32-bit operating system such as MS Windows 2000/XP. 

• Color monitor at 800x600 screen resolution. 

• An RS-232C port.

1.2. Installing ModemVU

ModemVU is available from the JAVAD GNSS website. If downloading the program from the website,
extract the program files into a folder on your hard drive.

1. If downloading the program from the website, extract the program files into a folder on your hard
drive.

2. Navigate to the location of the ModemVU program and double-click the Setup.exe icon. 
9www.javad.com                                                                                                                                                        



Getting Started
Setting up ModemVU
3. Follow the on-screen installation instructions (Figure 1). Click Next to continue, Back to get back
to previous step, or Cancel to quit the installation.

Figure 1. ModemVU Setup Wizard

4. Keep the default installation location or select a new location (Figure 2). 

Figure 2. Select destination folder

5. Click Finish to complete the installation.

6. If desired, create a shortcut on the computer’s desktop for quick access to ModemVU.
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Getting Started
Starting ModemVU
1.3. Uninstalling ModemVU 

To uninstall ModemVU use the Start menu on your computer:

1. Open the Control Panel, then Add or Remove Programs tool. Find ModemVU, and click Change/
Remove.

2. This will uninstall ModemVU.

Note: The previous version of the ModemVU software will be deleted by installing the newer.

2. Starting ModemVU 

Note: For the Windows 7 OS the software should be started “As administrator” or in the ModemVU properties
check the mark “Start as administrator”.

To run the software and connect with the ModemVU perform the following steps: 

• Connect the serial port of the computer to the serial port of the receiver at the switched off power
supply by using of a cable. 

• Connect the power supply (if it is necessary) to the receiver and switch on it. 

•  Run the ModemVU software on PC. 

You can start ModemVU just as you would any software application: 

• Double-click on ModemVU’s shortcut on the desktop (if it has been created), or 

• Press the Start button in the bottom-left corner of your computer’s screen and select ModemVU
from the pull-up menu. 
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Getting Started
Starting ModemVU
After that the window will appear as shown in Figure 3:

Figure 3. ModemVU Options

• Triumph-1 Internal Radio - for the internal UHF and/or GSM modem;

• Triumph-4 Internal Radio - for the internal UHF and/or GSM modem;

• Gismore for the internal GSM modem;

• ALPHA - for the internal GSM modem;

• SIGMA - for the internal UHF and/or GSM modem;

• JLINK - for the internal UHF and/or GSM modem;

• JLink Lite/JLink GSM - for the internal GSM modem;

• HPT435/435BT - for the external HPT435 or HPT435BT UHF modems.

• HPT402/404BT/404BT GSM - for the external HPT402 and HPT404BT UHF modems.

• HPT135BT - for the external HPT135BT UHF modems.

• HPT102/HPT104BT - for the external HPT102 and HPT104BT UHF modems.

• PDL - for the external PDL UHF modem.

• AW900BT - for the external AW900BT modem.

• AW401BT - for the external AW401BT modem.

• FH915 (OEM) - for the external FH915 modem
12                                                                                                                     www.javad.com



Getting Started
Starting ModemVU
1. Type the COM port number the receiver / the external modem is connected to (Figure 4) or select
the USB port ID if connection is via USB port. Click Connect.

Figure 4. Connect to ModemVU

If the TRIUMPH-1 Internal Radio is selected...

In the Connecting to device dialog window select the following (Figure 7 on page 14):

• To set up the UHF modem, ensure the GSM is OFF, then select ON in the Radio drop-down list box,
then click Apply  Connect Radio (Figure 5).

Figure 5. Connect to Radio

• To set up the GSM module, ensure the Radio is OFF and then click Connect GSM (Figure 6).

Figure 6. Connect to GSM

• Slave for base receiver;
• Master for rover receiver;
• GPRS for set up General Packet Radio Services (GPRS) and connect receiver to Internet
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Getting Started
Closing ModemVU
In the Connecting to Radio Modem window you will see the connecting progress bar (Figure 7 on
page 14).

Figure 7. Connecting to Radio modem progress bar

3. Closing ModemVU 

To quit ModemVU, select Exit from the menu or press CTRL+Q keys. If the receiver has not been
disconnected by the time you turn the program off, the connection will be automatically broken before
ModemVU is closed. 

To disconnect from the receiver, select the Disconnect option from the Tools menu or press CTRL+D
keys.

Warning: It is strongly recommended to close the connection with the receiver and close ModemVU prior to switching
the receiver OFF and disconnecting the cable.
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Chapter 2
OPERATION

1. Understanding Elements of the Tabs Window

After ModemVU has established a connection between the computer and receiver, the Tabs window will
be opened (Figure 1). This window can be split into three areas: the Menu bar, the Tabs control area,
which is the largest part of the window, and the Status bar.

Figure 1. Tabs Window

1.1. Menu Bar

The Menu bar extends across the top of the Tabs window and contains three menu titles through which
(or using the appropriate hot keys) the user can access the program functions. By hovering the mouse
pointer over a menu title and then clicking the left mouse button will cause the menu to drop down,
displaying a list of menu items. Position your pointing device on the desired menu item, then click and
release the left mouse button and that function is invoked (Figure 2).

Figure 2. Menu Bar with the Disconnect Item Highlighted

Menu Bar

Tabs area

Status Bar
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Operation
The Tabs window’s menu
1.2. Status Bar

The Status bar provides auxiliary information while using ModemVU. This information includes the
connection status, current communication settings, various types of messages (e.g., error messages).

1.3. Tabs Area

The Tabs area consists of tabs, varied for each modem type. You can use your mouse to position the
cursor over the desired control and then click a mouse button or you can use the Tab key to move around
the window.

2. The Tabs window’s menu 

The user can access any one of ModemVU’s dialog windows by selecting the corresponding item from
the Tabs window’s menu (Figure 3). 

Figure 3. The Tabs window’s menu 

The following sections will describe all available menu items and the corresponding dialog windows in
detail. 
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Operation
The Tabs window’s menu
2.1. File Menu

The File menu (Figure 4) contains three menu items:

Figure 4. File menu

Connect – by clicking this item, you open the Connection window through which you establish the
communication with a JAVAD GNSS receiver (see “Starting ModemVU” on page 12). If the JAVAD
GNSS receiver is already connected, this item will not be available. 

Disconnect – when you select this item, the connection with the JAVAD GNSS receiver will be closed. If
the JAVAD GNSS receiver is already disconnected, this item will be grayed out.

Exit - selecting this item, you quit the program.

2.2. Tools Menu

The Tools menu contains one menu item:

Options - Opens the Options window, circumstantially described in “Starting ModemVU” on page 12.

2.3. Help Menu

The Help menu contains only one item: 

About – Opens the About ModemVU window, which provides information about the current version of the
program, including its version number, release and expiration dates (Figure 5).

Figure 5. About ModemVU Window

OK – Closes the window.
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Operation
ModemVU for UHF Modem
3. ModemVU for UHF Modem

After establishing communication with the modem, the user will be presented with the following tab
controls: 

Radio Link– As follows from its name, allows configuring and editing various settings related to the radio
link between the modems. See “Radio Link Tab” on page 18.

Serial Interface& Tools– Allows loading the new version of modem firmware. See “Serial Interface &
Tools Tab” on page 22.

Identification– Shows the modem type and other information relating to the modem. See “Identification
Tab” on page 22.

Note: Use the Apply button to accept the changes you have made in each tab.

3.1. Radio Link Tab

The Radio Link tab is shown in Figure 6:

Figure 6. Radio Link tab
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Operation
ModemVU for UHF Modem
The Protocol drop-down list box (Figure 7) allows the user to select the protocol type: 

Figure 7. Protocol drop-down list box

• Simplex Receiver - This mode is used for JAVAD GNSS internal/external modem on rover side
when the base receiver is equipped with JAVAD GNSS internal/external modem.

• Simplex Transmitter - This mode is used for JAVAD GNSS internal/external modem on base side
when the rover receiver is equipped with JAVAD GNSS internal/external modem.

• Simplex Transmitter to Repeater - means the modem is enabled for transmission data from the
base receiver equipped with JAVAD GNSS internal/external modem to the Repeater.

• Simplex Repeater - JAVAD GNSS internal/external modem enabled as repeater, with no data
being passed to the local communications port.

• TRMB Receiver (only GMSK) - This mode is used for JAVAD GNSS internal/external modem on
rover side when the base receiver is equipped with Trimble internal/external modem. 

• TRMB Transmitter (only GMSK) - This mode is used for JAVAD GNSS internal/external modem
on base side when the rover receiver is equipped with Trimble internal/external modem.

• Transparent w/EOT Receiver (only GMSK) - This mode is used for JAVAD GNSS internal/
external modem on rover side when the base receiver is equipped with Pacific Crest PDL modem.

• Transparent w/EOT Transmitter (only GMSK) - This mode is used for JAVAD GNSS internal/
external modem on base side when the rover is equipped with Pacific Crest PDL modem.

• STL Receiver (only 4FSK) - This mode is used for JAVAD GNSS internal/external modem on base
side when the rover receiver is equipped with Satel modem (model SATELLINE-3AS).

• STL Transmitter (only 4FSK) - This mode is used for JAVAD GNSS internal/external modem on
rover side when the base receiver is equipped with Satel modem (model SATELLINE-3AS).

In the Frequency edit box (Figure 8) the user can set the necessary frequency:

Figure 8. Current frequency box
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Operation
ModemVU for UHF Modem
The Output power drop-down list box allows the user to set/query the output power value from 0.03W to
1W (Figure 9).

Figure 9. Output Power drop-down list box

Modulation Type - This setting specifies the type of modulation to be used: DBPSK, DQPSK, D8PSK,
16QAM, GMSK or 4 Level FSK (Frequency Shift Keying) (Figure 10). 

Figure 10. Modulation type

The choice of modulation affects the possible Link Rate. 

• DBPSK - Differential Binary Phase Shift Keying

• DQPSK - Differential Quadrature Phase Shift Keying

• D8PSK - Eight Phase Shift Keying

6.25 kHz 12.5 kHz 20 kHz 25 kHz

DBPSK 2.4 kbps 4.8 kbps 7.5 kbps 9.6 kbps

DQPSK 4.8 kbps 9.6 kbps 15.0 kbps 19.2 kbps

D8PSK 7.2 kbps 14.4 kbps 22.5 kbps 28.8 kbps

D16QAM 9.6 kbps 19.2 kbps 30.0 kbps 38.4 kbps

GMSK not available 4.8 kbps 7.5 kbps 9.6 kbps

4FSK not available 9.6 kbps 15.0 kbps 19.2 kbps
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Operation
ModemVU for UHF Modem
• D16QAM - Sixteen Quadrature Amplitude Modulation

• GMSK - Minimal Shift Keying with Gaussian Filtering

• 4FSK - Four Level Frequency Shift Keying

Link Rate - This drop-down list box (Figure 11 on page 21) allows user to select the rate at which data is
transmitted over the RF link. Whenever possible, it is recommended the use of 19.2 Kbps to minimize the
power consumption and to maintain the radio transmitter at a low TX duty cycle. You may need to use
4800 bps in order to maintain reliability in difficult transmission circumstances (long range or heavy fade
conditions).

Figure 11. Link Rate drop-down list box

Note that the choice of RF link rate affects the possible modulation types. 19.2 Kbps requires 4 Level
FSK, and 4800 bps requires GMSK modulation. Either is possible with 9600 bps.

Link Space - user selectable channel spacing (Figure 12) 

Figure 12. Link Space drop-down list box

Forward Error corrections - allows the receiving modem to correct burst and single bit errors in the
incoming data stream. When enabled, an additional 4 bits per byte of data is transferred over the RF link.
This effectively reduces the data throughput in proportion to the overhead bytes. Leave FEC enabled
unless the data throughput requirements make the overhead unacceptable.

Scrambling - Enable or disable data scrambling. Select the Scrambling check box if you want data to be
scrambled. Otherwise, keep it clear. For optimal operation of the GMSK modulation, data should be
scrambled. When enabled, the radio modem scrambles and unscrambles the data on transmission or
reception via an exclusive-OR operation with a pseudo-random bit stream. Do not disable scrambling
unless the DTE performs data scrambling and produces a data stream with approximately the same
number of 1's and 0's. Use the Apply button to accept the changes you have made in the tab.
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ModemVU for UHF Modem
3.2. Serial Interface & Tools Tab

This tab is shown in Figure 13. With this tab the user can load the new modem firmware. Click the
Download FW button, browse and select the file with new firmware. Click Ok to load the new firmware. 

Figure 13. Serial Interface Tab

3.3. Identification Tab

The Identification tab provides you with information about modem type, Hardware and firmware
versions, and serial number. Figure 14 shows an example of this window. 

Figure 14. Identification Tab
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4. ModemVU for GSM/GPRS Module

After establishing connection with the GSM Modem, the user will be presented with the following tab
controls: 

General - Allows configuring and editing the general settings. See “General Tab” on page 23 for details.

Master/Slave - As follows from its name, allows configuring and editing various settings related to the
master or slave modem’s mode. See “Master/Slave Tab” on page 26 for details.

GPRS - Allows configuring and editing various settings related to the GPRS mode. See “GPRS Tab” on
page 27 for detailed information.

Dialup - Allows configuring and editing various settings related to the dialup mode. See “Dialup Tab” on
page 28 for details.

Service - Allows configuring and editing different parameters of service. For details see “Service Tab” on
page 29.

Note: Use the Apply button to accept the changes you have made in each tab.

4.1. General Tab 

The General tab is depicted in Figure 15. 

Figure 15. General Tab

This tab allows user to setup the modem mode, enter PIN code of SIM-card, see GSM information and
select necessary network. In this tab modem and service status and possible errors are displayed.
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Mode drop-down list box allows user to select and setup the GSM modem mode:

Figure 16. Mode drop-down list box

• OFF means GSM modem is inactive. To change modem’s modes user has to set modem’s mode
firstly to OFF and press Apply button, then select and setup the necessary mode from the list. OFF
mode means modem’s hardware reset.

Note: Modem’s hardware reset is possible if the GSM modem is internal.

• Slave means registered in GSM network modem is waiting an incoming call to send a data. The
Slave mode is required modem mode for the receiver configured as a base.

• Master means registered in GSM network modem is dialing up and establishing connection with
other modem, using dial number set in “Master/Slave Tab” . If the established connection is
interrupted, modem dial up and connect anew. The Master mode is required mode for the receiver
configured as a rover. To setup Slave or Master mode parameters see “Master/Slave Tab” on page
26.

Note: In the current firmware implementation, the master mode should be used for the rover receiver only, and
the slave mode should be used for the base receiver only.

• GPRS means registered in GSM network and in GPRS network modem connects with Internet via
GPRS. To setup GPRS parameters see “GPRS Tab” on page 27.

• Dialup means a form of Internet access using a modem connected to a receivers port and a
telephone line to dial into an Internet service provider's (ISP) node to establish a modem-to-
modem link, which is then routed to the Internet. To setup necessary dialup parameters see
“Dialup Tab” on page 28.

PIN Code box allows the user to enter the Personal Identification Number (PIN) of its SIM-card.

If you have inserted the wrong PIN you will see the error message in modem status box (Status subtab)
and “pin” message in modem error box (Error subtab). To enter correct PIN it is necessary to set modem
in OFF mode, then enter PIN anew.

If you have entered more than 4 characters or illegal characters you will see the warning (Figure 17):

Figure 17. PIN Warning
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GSM info button opens the window with information about cell operator, signal quality, model and serial
number of your receiver’s GSM modem (Figure 18). 

Figure 18. GSM info

Quit button closes the window.

Status and Error Subtabs

There are two subtabs in General Tab: Status and Error. These tabs show current modem status, service
status, link quality (Status subtab Figure 20 on page 25) and possible modem or service errors (Error
subtab Figure 19).

Figure 19. Error subtab

.

Figure 20. Status subtab
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• Modem - this box changes its name depending of the settings made in Mode drop-down list box
(see Figure 16 on page 24). For OFF, Slave or Master (in Mode drop-down list box) it will be
Modem, for GPRS or Dialup it will be GPRS or Dialup correspondingly.

This box displays the current status of modem, GPRS or Dialup connection (off, ready, detecting,
connecting/disconnecting, connected/disconnected, etc.).

• Service box displays the current service status (connecting/disconnecting, disconnected/
connected).

• Link Quality box displays the link quality of connection.

4.2. Master/Slave Tab

Master/Slave Tab is depicted in Figure 21. This tab allows user to setup the dial number, send and receive
time out intervals.

Figure 21. Master/Slave tab

The Dial number box allows the user to set/display a dial number, the phone number of the slave modem
to be dialed in to. The number you can insert is a string comprising up to 14 a/n characters.

Note: Mandatory only when running the GSM modem in master mode.

The Send Time Out box allows the user to set/display a time interval of the service word. The transmit
modem will send the service word to the receive modem in every N seconds, where N is a time interval in
seconds from 0 to 255. 0 stands for disabled. 

Note: If the receiver has not received any data from the modem for designated seconds, the modem will be
disconnected and then re-initialized. 

In the Receive Time Out box is possible to set/display a time interval of the service word. The receive
modem will receive the service word from transmit modem in every N seconds, where N is a time interval
in seconds from 0 to 255. 0 stands for disabled. 
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Note: To ensure reliable and secure modem communication, the Receive Time Out value must be always larger
then the period of transmitting differential corrections. Also, care should be taken that the time interval in
Receive Time Out box is greater than the service word repeat period by 2 to 3 seconds.

4.3. GPRS Tab

GPRS Tab is depicted in the Figure 22. This tab allows user to setup all necessary GPRS settings like dial
number, user name and password, and to tune GPRS using AT commands. 

Figure 22. GPRS Tab

GPRS Tab consist of two subtabs: Main and AT Commands.

In the Main subtab (see Figure 22) it is necessary to set the dial number, user name and password, access
point name and PDP context identifier to establish a GPRS connection. As usually, this information is
given by cell provider.

AT Commands subtab (Figure 23) is designed for advanced users for finest GPRS tuning. By default, all
the settings have the zero value. 

Figure 23. AT Commands subtab

Note: We recommend that you do not send any AT commands to the GSM modem from the AT Commands
subtab before acquire good knowledge of the GPRS parameters.
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PPP button

This button opens the PPP parameters window, that allows user to set up the Point-to-Point protocol
parameters (Figure 24):

Figure 24. PPP parameters window

The Point-to-Point Protocol, or PPP, is commonly used to establish a direct connection between two
nodes. As usually, information of PPP parameters is given by Internet service provider.

To close this window press Exit.

4.4. Dialup Tab

The Dialup Tab is depicted in Figure 25.

Figure 25. Dialup Tab

It is necessary to set the dial number, user name and password to establish a dialup connection. As
usually, this information is given by Internet service provider.

Init - This field contains chat script to initialize dialup modem. The chat script defines a conversational
exchange between the receiver and the modem. The syntax and semantics of the chat script used by the
receiver matches those of the widely used “chat” program (see, e.g., http://docs.freebsd.org/info/uucp/
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uucp.info.Chat_Scripts.html for documentation), except the '@' character is used instead of cartridge
return to separate chat commands.

Note: We recommend that you do not type any commands to the GSM modem in the Init field before acquire
good knowledge of the dialup parameters.

For information about PPP button see, please, “PPP button” on page 28.

4.5. Service Tab

This tab is depicted in Figure 26 and allows user to setup the service parameters. It consist from four
subtabs: Main, RCV, NTRIP

Figure 26. Service Tab

Main Subtab

The Main subtab is depicted in Figure 27. In this subtab the user can select and setup the necessary
service mode like RCV, or NTRIP and different input modes. 

Figure 27. Main subtab
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Mode drop-down list box allows user to select and setup one of the following modes (Figure 28):

Figure 28. Mode drop-down list box

• OFF means service is disabled.

• RCV means that modem will receive data from another (remote) JAVAD GNSS receiver
configured as a base station. This base station have to be connected with Internet via Ethernet or
GPRS and have static IP address. To setup the RCV parameters see “RCV Subtab” on page 31.

• NTRIP is useful to provide a method to establish connection to an NTRIP caster, request data
from particular mount point, and then receive and use the data as RTK/DGPS corrections. For
detailed description of NTRIP settings see “NTRIP Subtab” on page 31.

In the Input mode TCPCL port drop-down list box (Figure 29) the user can setup different input modes.
With this parameters it is possible to specify what type of incoming data to accept on the TCPCL receiver
port.:

Figure 29. Input mode TCPCL port drop-down list box

• None means that the port will ignore any incoming data.

• Command - port is in command mode. Being in this mode, the receiver's port recognizes
commands sent by the user.

• Echo - echo mode.

• RTCM 2.x - RTCM 2.x input mode.

• RTCM 3.x - RTCM 3.x input mode. In this mode the receiver recognizes and decodes the RTCM
3.x messages received through the port.

• CMR - CMR/CMR+ input mode. For more information on CMR format, please refer to ftp://
ftp.trimble.com/pub/survey/cmr.

• JPS - JPS input mode. In this mode receiver is capable to recognize both standard and non-
standard JPS messages.

• Omni - unsupported.
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RCV Subtab

The RCV subtab is depicted in Figure 30. This tab allows user to setup the parameters for RCV service
mode:.

Figure 30. RCV subtab

• IP address - IP address of base station.

• Port - base station’s port

• Login - designation of base station’s TCP port (A, B, C, D, E or empty).

• Password - password of base station.

• IP address, Port, Login, and Password are the parameters of other receiver, configured as a base
station and connected with Internet via Ethernet or GPRS.

Note: The description of these parameters exceeds the scope of this document, see TriVU Software Manual,
available from http:///www.javad.com, for detailed information of base station’s configuration and
Ethernet and TCP port settings.

NTRIP Subtab

The NTRIP subtab is depicted in Figure 31. 

Figure 31. NTRIP subtab

• IP address - The value of this field should match the IP address of the NTRIP caster to use.

• Port - The value of this field should match the IP port the NTRIP caster is listening on for
connections.
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• User - This parameter specifies user ID for the protected space of the requested mount point.Only
basic authentication scheme is supported. If empty, no user or password values will be sent to the
NTRIP caster.

• Password - This field specifies the password for the protected space of the requested mount point.
Only basic authentication scheme is supported.

Note: As usually, this information is given by NTRIP service provider.

• NMEA - this box allows using appropriate parameter to receive/no receive the GGA messages for
NTRIP caster:

• -1 – receiver will not send NMEA GGA messages to NTRIP caster.
• 0 – receiver will send NMEA GGA message to NTRIP caster only once after connection to the

caster is established.
• [1…86400] – receiver will send NMEA GGA messages to the NTRIP caster periodically, every

specified number of seconds.

• Mountpoint drop-down list box allows to select the necessary mount point from the list (Figure 32
on page 32). This drop-down list box specifies the mount point of the NTRIP caster to get data
from. The detailed information about each mount point it is possible to obtain and view pressing
the Source Table button.

Figure 32. Mountpoint drop-down list box
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Source table button

Source table button opens the Stream Details window, depicted in Figure 33.

Figure 33. Stream Details window

This window presents stream information and allows to view and select the necessary mountpoint from
the list. With buttons Previous, Next, and Select it is possible to view and select available streams. Cancel
closes the window.

If in Stream Details window in the Client must send NMEA-GGA line stand No, the following warning
will appear “This Mountpoint does not require sending NMEA. Parameter NMEA can be -1”: 

Figure 34. NMEA Warning
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If in Stream Details window in the Client must send NMEA-GGA line stand Yes, the following warning
will appear “This Mountpoint requires sending NMEA. Parameter NMEA should be from zero upward”:

Figure 35. NMEA Warning
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Chapter 3
TROUBLESHOOTING

This chapter can help the user to solve some of the problems that may occur while using ModemVU.

1. Things to Check First

Before contacting JAVAD GNSS Customer support about any problems with the receiver, refer to the
following list of basic suggestions that may help:

• Go through all external receiver connections carefully and make sure they are not wrong or loose.

• Double-check the cables. Cables became defective more often than the devices do.

• Check the sections below for available solutions.

• Reset the receiver using TriVU (ToolsReset receiver).

• Restore factory default settings using TriVU (click ConfigurationReceiver, then Set all
parameters to defaults).

• Clear the NVRAM.

• Initialize the file system (click ToolsInitialize file system; this will erase all files inside the
receiver).

Warning: Do not attempt to repair equipment yourself. Doing so will void your warranty and may damage the hardware.
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2. Troubleshooting Chart

The chart below covers most of the difficulties that the user might encounter. The first column contains
the error messages that appear in the status bar.

Problem

Can’t find modem.

Causes Solutions

The receiver’s is turned off. Make sure that your receiver is getting power and is turned on. 

The cable’s connectors are 
not properly plugged in.

Check the connections to make sure they are not loose. Check the cables running from 
the receiver’s port to the computer port to ensure they are tight as well.

The cable is damaged. Use an undamaged cable.
Contact your Dealer to replace the cable. 

The receiver port used for 
connection is not in 
Command mode.

Restore Command mode for this port:
Connect your receiver and a computer using a free port, such as port D, and start 
TriVU.
Click ConfigurationReceiverPorts.
Change the Input for the serial port used for connection to Command.

The computer port you 
have selected for 
connection is not the same 
as you specified in the PC 
Serial Port control.

Check that your receiver is connected to your PC using the proper RS232 cable for 
connection to a PC and make sure that the cable is exactly plugged into the same PC 
serial port as you specified in the Port’s setting drop down list of the ModemVU 
software.

Problem

Open COM# port failed: Access is denied.

Causes Solutions

The computer port 
dedicated for connection is 
in use by another 
application.

Close the application that uses this port or connect to the receiver via another free 
computer port.
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